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End User License Agreement 

CAREFULLY READ THE FOLLOWING LICENSE AGREEMENT. THIS DOCUMENT IS A 
LEGAL AGREEMENT BETWEEN YOU, AND DIAGNOSTIC INSTRUMENTS, CONCERNING 
THE USE OF THE ENCLOSED SOFTWARE.  THIS AGREEMENT CONSTITUTES THE 
COMPLETE AGREEMENT BETWEEN YOU AND DIAGNOSTIC INSTRUMENTS. 
 
BY OPENING THE SOFTWARE PACKAGE OR USING THE CD, YOU ARE CONSENTING TO BE 
BOUND BY AND ARE BECOMING A PARTY TO THIS AGREEMENT. IF YOU DO NOT AGREE 
TO ALL OF THE TERMS OF THIS AGREEMENT, DO NOT OPEN THE PACKAGE OR USE THE 
CD.  PROMPTLY RETURN THE CD, INCLUDING THE WRITTEN MATERIALS, THE BINDER, 
AND ALL OTHER EQUIPMENT/CONTAINERS TO THE DEALER FROM WHOM YOU 
PURCHASED THEM.  YOU WILL RECEIVE A FULL REFUND. 

License Grant 
The package contains software ("Software") and related explanatory written materials ("Documentation"). 
"Software" includes any upgrades, modified versions, updates, additions and copies of the Software. "You" 
means the person or company who is being licensed to use the Software or Documentation. "We" and "us" 
means Diagnostic Instruments, Inc. 
We hereby grant you a nonexclusive, limited license to use one copy of the Software on any single 
computer, provided the Software is in use on only one computer at any time.  The Software is "in use" on a 
computer when it is loaded into temporary memory (RAM) or installed into the permanent memory of a 
computer—for example, a hard disk, CD-ROM or other storage device.  

Title 
We remain the owner of all right, title and interest in the Software and Documentation.  You will agree to 
use your best efforts to protect the software from unauthorized use, illegal reproduction, or illicit 
distribution. 

Copyrights and Trade Secrets   
Diagnostic Instruments owns all rights to the Software.  This agreement does not convey ownership of the 
software to you, but only the right to use a copy of the software strictly in accordance with this agreement.  
The unauthorized duplication or distribution of the software or the documentation is an infringement of 
Diagnostic Instruments' rights to the software and may be subject to criminal and/or civil penalties. 

Archival or Backup Copies 
You may either: 
• Make one copy of the Software solely for backup or archival purposes, provided that the original 

copyright notice and/or other legend is reproduced on each copy, or 

• Transfer the Software to a single hard disk, provided you keep the original solely for backup or 
archival purposes, and provided that the original copyright notice and/or other legend is reproduced on 
each copy. 

Things You May Not Do 
United States copyright laws and international treaties protect the software and documentation. You must 
treat the software and documentation like any other copyrighted material--for example a book. You may 
not: 
• Copy the Documentation (although you may print one working copy from a downloaded version from 

our website), 

• Copy the Software except to make archival or backup copies as provided above, 

• Modify, translate, or adapt the Software or merge it into another program, 
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• Make any attempt to discover the source code of the Software through reverse engineering, 

• Place the Software onto a server so that it is accessible via a public network such as the Internet, 

• Sublicense, rent, lease or lend any portion of the Software or Documentation. 

Transfers 
You may transfer all your rights to use the Software and Documentation to another person or legal entity 
provided you transfer this Agreement, the Software and Documentation, including all copies, updates and 
prior versions to such person or entity and that you retain no copies, including copies stored on computer. 

Software Limited Warranty 
We warrant that for a period of 30 days after delivery of this copy of the Software to you: 
• The physical media (if any) on which this copy of the Software is distributed will be free from defects 

in materials and workmanship under normal use, and 

• The Software will perform in substantial accordance with the Documentation. 

To the extent permitted by applicable law, THE FOREGOING LIMITED WARRANTY IS IN LIEU OF 
ALL OTHER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, AND WE DISCLAIM ANY 
AND ALL IMPLIED WARRANTIES OR CONDITIONS, INCLUDING ANY IMPLIED WARRANTY 
OF TITLE, NONINFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE, regardless of whether we know or had reason to know of your particular needs. No employee, 
agent, dealer or distributor of ours is authorized to modify this limited warranty, or to make any additional 
warranties. 

Limited Remedy 
Our entire liability and your exclusive remedy shall be: 
• The replacement of any CD (s) or other media not meeting our Limited Warranty which is returned to 

us or to an authorized Dealer or Distributor with a copy of your receipt, or 

• If we or an authorized Dealer or Distributor are unable to deliver a replacement CD (s) or other media 
that is free of defects in materials or workmanship, you may terminate this Agreement by returning the 
Software and Documentation and your money will be refunded. 

IN NO EVENT WILL WE BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST 
PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING 
FROM THE USE OF OR THE INABILITY TO USE THE SOFTWARE (EVEN IF WE OR AN 
AUTHORIZED DEALER OR DISTRIBUTOR HAS BEEN ADVISED OF THE POSSIBILITY OF 
THESE DAMAGES), OR FOR ANY CLAIM BY ANY OTHER PARTY. 

Term and Termination 
This license agreement takes effect upon your use of the software and remains effective until terminated. 
You may terminate it at any time by destroying all copies of the Software and Documentation in your 
possession. It will also automatically terminate if you fail to comply with any term or condition of this 
license agreement. You agree on termination of this license to either return to us or destroy all copies of the 
Software and Documentation in your possession. 

Confidentiality 
The Software contains trade secrets and proprietary know-how that belong to us and it is being made 
available to you in strict confidence. ANY USE OR DISCLOSURE OF THE SOFTWARE, OR OF ITS 
ALGORITHMS, PROTOCOLS OR INTERFACES, OTHER THAN IN STRICT ACCORDANCE WITH 
THIS LICENSE AGREEMENT, MAY BE ACTIONABLE AS A VIOLATION OF OUR TRADE 
SECRET RIGHTS. 

General Provisions 
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• This written license agreement is the exclusive agreement between you and us concerning the Software 
and Documentation and supersedes any and all prior oral or written agreements, negotiations or other 
dealings between us concerning the Software. 

• This license agreement may be modified only by a written agreement signed by you and us that 
specifically supersedes this agreement. 

• The laws of the State of Michigan govern this license agreement. 

• You agree that the Software will not be shipped, transferred or exported into any country or used in 
any manner prohibited by the United States Export Administration Act or any other export laws, 
restrictions or regulations. 

Trademarks 
Adobe Photoshop is a registered trademark of Adobe Systems Incorporated.  Image Pro and Image Pro Plus 
are registered trademarks of Media Cybernetics.  SPOT, Idea, Insight, RT, RT-KE, RT-SE, Flex, Xplorer, 
Xplorer XS, Pursuit, Pursuit XS, Correct Color Technology, Enhanced, and Boost are trademarks of 
Diagnostic Instruments, Inc.  Windows 95, Windows 98, Windows 98SE, Windows NT, Windows 2000, 
Windows ME, and Windows XP, Windows Vista, and Windows Office are registered trademarks of 
Microsoft, Inc.  Mac OS is a registered trademark of Apple Computer, Inc.  FireWire is a registered 
trademark of Apple Computer, Inc. and a licensed trademark of the 1394 Trade Association.  All other 
product names mentioned in this document are the property of their respective trademark holders. 

Camera Warranty Information 
LIMITED WARRANTY: Diagnostic Instruments, Inc. (henceforth referred to as Diagnostic) warrants to 
the original purchaser, that the camera will be free of defects in material and workmanship for a period of 
two (2) years from the date of purchase.  Refurbished cameras may offer a different term of warranty.  
Please refer to the warranty associated with refurbished equipment at the Diagnostic Instruments website 
and/or enclosed in the shipping container. 
 
Diagnostic shall, at its choice, repair or replace, free of charge, any product that, upon inspection by 
Diagnostic, is found to be defective.  Abuse, misuse, or improper maintenance and/or repair during the 
warranty period invalidate this warranty.  This warranty does not cover defects due to ordinary wear and 
tear. 
 
In no event shall Diagnostic be liable for any consequential, indirect, incidental, or special damages of any 
nature arising from the sale or use of this product.   
In no event, and under no circumstance shall Diagnostic be liable to the Dealer or to any other individual or 
entity for any indirect, special, consequential, or incidental losses or damages, including without limitation, 
lost profits. 
EXCEPT, AS EXPRESSLY SET FORTH IN THIS AGREEMENT, DIAGNOSTIC INSTRUMENTS, 
INC., MAKES NO WARRANTIES OR REPRESENTATIONS TO THE DEALER OR USER, EITHER 
EXPRESS OR IMPLIED.  THIS INCLUDES, WITHOUT LIMITATION, WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR THE VALIDITY, NON-
INFRINGEMENT, OR OWNERSHIP OF ANY PATENTS OR TECHNOLOGY IN OR CONCERNING 
THE CAMERA.  DIAGNOSTIC INSTRUMENTS INC., HEREBY EXPRESSLY DISCLAIMS ALL 
SUCH WARRANTIES, GUARANTIES, REPRESENTATIONS, OR CONDITIONS. 

Diagnostic Instruments reserves the right to change any or all of this policy at any time. 
Copyright 2005, Diagnostic Instruments, Inc.  All rights reserved. 
 
V4.7.0 
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About This Manual 

Introduction 
This software user guide is designed as a supplement for the SPOT Software User Guide for version 4.7 
and contains instructions for using the 4.7 Advanced Plus version of SPOT software with the following 
camera lines: Idea, Insight, RT, Flex, Xplorer, Pursuit, and Boost.  Some features described in this manual 
apply only to specific camera lines, or to specific types of cameras within those lines.  In these cases, the 
camera line or type of camera is listed in parentheses after the feature name.   

A PDF (portable document format) version of this document has been included on the CD that contains the 
SPOT software.  Refer to your installation manual for installation procedures and technical specifications 
specific to your particular camera line. 

Document Conventions  
The following is a list of the textual conventions used in this manual: 

Notes  Note:  This is an example of a note.  Notes appear within the text to indicate 
information for further consideration or reference. 

 

Cautions 
CAUTION! 

This is an example of a cautionary note.  Cautionary notes appear to indicate that 
you should carefully consider the implications of an action. 

  

Warnings 
WARNING 

THIS IS AN EXAMPLE OF A WARNING.  WARNINGS INDICATE THAT THE ACTION 
YOU ARE TAKING COULD EITHER CAUSE INJURY TO YOURSELF OR COULD 
HARM YOUR SYSTEM 
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Organization of the Manual 
The Spot 4.7 Advanced Plus Supplemental User Guide is structured as shown in the table below.  In 
addition to the chapter names and descriptions, the table indicates whether the chapter applies to the Basic 
program mode, the Advanced program mode, or both: 

 
Chapter 

 
Description 

About This Manual Describes document conventions, manual structure. 

Ch. 1 – Program 
Features 

Describes SPOT Advanced Plus Features in addition to SPOT 
Advanced program features in order of their menu placement. 

Ch. 2 – Boost Features Describes features available for Boost cameras. 
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Chapter 1 - Program Features 
This chapter outlines the features which are unique to the SPOT Advanced Plus software package as they 
appear in the menu listings.  

File Menu 
 
Duplicate Image 
Creates a duplicate image so that a copy is available to further 
manipulate, or you can create a duplicate of the original image 
after manipulation.  If changes have been made to the display 
of the image, you will have the option to either duplicate the 
raw, actual image data or duplicate the displayed image data.  
You can also set the bit depth of the newly created image and, 
if any annotations, calibrations, or measurements have been 
added to the image, you can choose to Merge all of these 
objects to the image.  The option to Merge Objects in layers is 
only available when selecting As Displayed.   

Create Extended Focus Image 
This feature allows you to create one single best image from a series of images where the focus, contrast, or 
intensity may not be even across a single plane of focus.  You can use either the Entire Image Area or a 
Selected Area from which to create the Extended Focus Image.  
 
If the Entire Image Area is selected, the entire image data will be used with the selected Method for 
creating the Extended Focus Image. 
 
To use a Selected Area, make this selection in the Create Extended Focus Image dialog box and then use 
your cursor to click drag a rectangular selection on one of the open images.  Only the pixel data within this 
area will be used for creating the new Extended Focus Image.  The entire original image area will still be 
displayed while the Selected Area will reflect the method chosen for creating the Extended Focus Image.  
There are three Methods available for creating an Extended Focus Image: 
 

• Best Local Contrast-The best contrast at each point, or 
neighborhood, is analyzed throughout all indicated 
images and the best contrast image data is used to 
create one final image.  The user has the ability to set 
the size of the neighborhood for this process.  A grid of 
pixels either 3X3, 5X5, or 7X7 in dimension can be 
used. 

 
• Best Local Image-The single image, from all indicated 

images, with the best overall contrast will be used to 
create a new image file. 

 
• Maximum Projection-The brightest pixel data at each pixel position throughout all indicated 

images will be used to create one final image.   
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Export Pixel Values 
Exports and saves the image data to either a 
binary or text format file.  If only a selected 
region of the image is desired, this area can 
be selected prior to accessing this feature 
and using the ‘Selection’ option.  If a 
selection is not indicated on the image prior 
to accessing the Export Pixel Values feature, 
the option for ‘Entire Image’ or ‘Selected 
Area’ will be unavailable and grayed out.   
  

Edit Menu 

Preserve Pixel Intensity Data 
When this feature is activated, the actual image data will be preserved throughout image manipulations.  
Preserve Pixel Intensity Data can be set in the Image Setup to ensure data integrity for all captured images.  
Also, under the Edit menu, you can make the selection to activate or de-activate the Preserve Pixel Intensity 
Data feature. 
When turned on, certain functionality will be disabled in the software so that the raw pixel data can not be 
altered.  If “Preserve Pixel Intensity Data” has been selected for an image and you de-activate this feature 
from the Edit menu, you will be asked to verify this choice.  Once Preserve Pixel Intensity Data is turned 
off, any changes made to the way the image is displayed will permanently change the pixel data which is 
saved. 
 
 
Set Intensity Display Scaling 
This feature is accessible from the menu command or by clicking on the icon on the Image 
Display Settings Panel (see View menu section). 

Any changes made to these settings will only change the way an 
image is displayed as long as Preserve Pixel Intensity Data is 
activated for the image. 

• Scaling- 

 Off-Default selection to apply no change to the 
stretching of the black and white points of the image 
display. 

Manual-Enter a set value to which you would like 
the Black and/or White points to be reset for image 
display.   

 Auto-Enter a value in the form of a percentage to 
adjust the black and white points for image display.  
The value indicated will be the percentage of pixels 
that will become Black/White. 

• Gamma-Gamma Adjust smoothly lightens darker areas of 
an image without burning out bright areas or lightening black areas. This is especially useful for 
editing images with a wide range of brightness values (dynamic range).  Values above 1 will 
brighten and values below 1 will darken the image display. 

• Histogram Area-Adjustments to this selection will change the information that is displayed in the 
histogram as well as define the area that will be used for calculating black/white values as 
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indicated in the Scaling section.  You can either choose to use the Full Image Area or select a 
Region.  If you choose a Region, you can set the pixel values to define a rectangular area, or if a 

previous selection (click and drag) was made from the Select/Show Histogram Area,  these 
pixel values will be displayed here. 

The values that are set for the Intensity Display Scaling can be saved to an image setup via the Set Image 
Display Values (See Camera Menu section). 
 

View Menu 

Show Image Display Settings Panel 
The panel below is the Image Display Settings Panel which can be toggled on and off from the View menu.  
If this feature is activated, the panel will be displayed within the image window.  The Image Display Panel 
feature can be turned on or off as a Preference under the Setup Menu. 
 

 
 
This feature allows easy access for many tools for adjusting the way your image is displayed.  Certain tools 
will not be available for color images (i.e.  Set Palette and Indicate Saturated Pixels). 
 
Histogram View of Pixel Data:  A graphical representation of image pixel data which allows for quick 
adjustments by grabbing on to the end pointers (to scale the white and black points, or the center pointer (to 
adjust the Gamma). 
 
Set Intensity Display Scaling: This button will bring up a dialog box to enter values for Scaling the image, 
adjusting the Gamma, or to set the area of the image which is represented in the Histogram.  This dialog 
box is also available from the Edit menu. 
 
Set/Show Histogram Area:  If this toggle button is depressed, the area of the image which is graphically 
represented in the histogram will be outlined in turquoise.  If the entire image is being used for the 
histogram display, the turquoise outline will not be viewable.  The menu listing can also be used to 
show/hide the histogram selection area. 
 
Set Palette:  Use this button for quick access to existing color Palettes or create a New Palette. 
 
Indicate Saturated Pixels:  This button allows for easy toggling of viewing saturated pixels. 
 

Show Image Display Histogram Area 
Use this feature to toggle the display (with a cyan rectangle) of a selected region that is used for the 
Histogram (see Show Image Display Settings Panel).   
 



Program Features 

 

SPOT Software User Guide – Advanced Plus Supplement  10 

Camera Menu 

Save Image Display Values 
With an image open in the SPOT application, the option to Save Image 
Display Values will be available.  If you like the values that you have used on 
an image for Scaling, Gamma, Palette selection, etc, you can use those values 
from the image and save them to the Image Setup of your choice. 

Setup Menu 

Peripheral Devices – (Peripheral Device Controller) 
What is the Peripheral Device Controller? 
The peripheral device controller allows the SPOT program to communicate 
with external devices.  This provides a means for directing the external device 
to obey simple commands.  As most external devices (filter wheels, shutters, etc.) will have their own 
unique set of commands that they obey, you will need to access the reference documentation of the external 
device in order to make use of this function in SPOT software. 
Why and when would I use this feature? 
One of the powerful uses of the peripheral device controller is to automatically change the condition of the 
external device while you carry out an experimental process.  This is most powerful when the peripheral 
device control commands are placed in a Macro (see chapter 13 – Macro Scripting to learn or review the 
use of the Macro feature). 

WARNING 
Note:  External Devices are typically electromechanical devices that may have their own hazards of use.  
Before you attempt to use any external device alone or in conjunction with SPOT software, refer and abide 
by all instructions and warnings that accompany that external device.   
Particularly note the potential hazards associated with the use of that device and do not attempt to control 
that device without being able to view its operation from the control location, including the computer 
running the SPOT software. 
Additionally, note the limitations of the device you are controlling.  Do not set the SPOT software to 
exceed those limitations as doing so could result in damage to the external device or a hazardous situation 
to the user. 
 
 
Developing Peripheral Device Commands 

Once you have the external device’s documentation and then locate its 
command list, you are ready to begin. 
Access the peripheral device set-up editor by selecting it from the Setup 
dropdown menu on the menu bar. 
 
The Peripheral Devices window will appear and will initially be empty.  
Select the Add button to begin. 
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Naming the External Device - Start by giving the device you are controlling a name that you will 
recognize.  For example, if you are developing commands for a Sutter filter wheel, you might want to name 
the device as such.  Be as general or specific as you need to be depending upon the number and type of 
external devices you could connect to your computer. 
 

 
 
Specifying the Device’s Communication Settings - Before you push the add button, you may specify the 
communication information of your external device.  To begin, specify the output port that the 
communication cable is connected from at your computer (The other end will be attached to the external 
device controller).  Select this from the dropdown menu in the PORT box. 
 
You will often find the other communication information in the external device reference manual, in the 
same section as the external command list or in the specification section.  As an example, the following 
excerpt is from the Uniblitz VMM-D1 Shutter’s User Manual. 
 
RS-232C (DB-9 female)  Baud rate 9600, 8 Data bits, 1 Stop bit, No parity, No flow 

control, command acquisition time 0.94 msec; 6 commands 
available; 1 global, 8 local address locations for commands 
(see "ADDRESS Select" specification for switch settings of 
local address locations).  
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Note that the specification tells you the type of communication mode (RS232C) and gives you 
communication specifications including Baud rate, the number of data bits, the number of stop bits, 
whether there is a parity bit or not and what type it is. 
 
Select the matching information from one of the drop down menus for each Baud Rate, Parity, Data Bits, 
and Stop Bits. 
 
Alternatively, you can select the Use System Port Settings checkbox.  The boxes for the technical 
information noted above will become inactive.  The communication will default to the settings specified for 
that port on your computer. 
 
 
 
Note: The communication information must match between that specified and that of the external 
device.  Otherwise, information exchange may be flawed and the external device controller may not 
understand the external device commands. 
 

Push the add button to add a command name to your library. 
 
Naming the External Device Command - You will want to 
name the peripheral device command.  You can name it 
whatever you choose without regard for the function that the 
command will send to the external device.  Logically, 
however, you probably want it to be closely related to the 
function (i.e. “Open the shutter” might be better than “Bob’s 
eye-opening experience”) especially if other users may be 
accessing these commands. 
 
Entering the Desired Command - Once you have named 
the command, you must enter the corresponding command 
string in that box that will be understood by the external 
control device.   
 
 
 

 
 
The following special notation can be used in the command string: 

   $ ........................ “Escape” character 

   ^A-^Z ...............Control A through control Z 

   \$.......................Dollar sign 

   \\........................Backslash 

   \^....................... “^” character 

   \b10101010......Binary value “10101010” expressed in true binary 

   \dyy...................  value “yy” expressed in decimal 

   \xyy................... value “yy” expressed in hexadecimal 

For example, the following command options would be available for the Uniblitz VMM-D1 shutter.  Note 
that the Peripheral Device Command feature will not support the Octal command codes listed in the 
following table. 
 
RS232 Global Address Codes      
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If you wanted to send the “Open” command in hexadecimal, you would type the following:  
 

 
 
 Note:  You no longer need to use three alphanumeric characters to describe a decimal command.  

For example, the previous command \d05 can now be specified as \d5.   
 
Setting a Response Command - You may elect to receive a response when the SPOT program has sent the 
command, and the external device has completed that command.  Click on the Response String checkbox 
and type in the appropriate response command.  This response command string will also be found, if 
available, in the external device documentation. 
 
Using Variables - In the command string, you may insert variables.  The variables will be expanded at the 
time that the command is sent to the device.  If you insert a "RunTimeText" variable, the user will be 
prompted, with your supplied prompt text, at the time the command is sent, and the user's response will be 
inserted into the command string at the point where the variable appears.  The "TextVar" and "NumVar" 
variables may be useful when the command is used from within a macro (see Chapter 13 – Macro 
Scripting).   
 
Using Timeouts - You may also select a time limit between the time that the command is sent by SPOT 
and the time it takes for the command to be received and the action of the function is completed.  This can 
be handy in letting you know that there is a communication problem between the computer and the external 
device, when you expect an action to take place within a prescribed length of time. 
 
Testing the Peripheral Device Command - You may test the command immediately by selecting the Test 
button.  If you have selected timeout duration, a response window will let you know if the command has 
not been received and carried out within the prescribed length of time. 
 
 
 Note: Make sure your external device is connected properly to the computer and that it is turned on 

       
 Commands  Decimal  HEX  Octal  Binary  ASCII 
 Open  64  40  100  01000000  @ 
 Close  65  41  101 01000001  A 
 Trigger  66  42  102  01000010 B 
 Reset  67  43  103  01000011 C 

 Open B  68  44  104  01000100 D (sets AUX Pin-1 
low) 

 Close B  69  45  105  01000101  E (returns AUX Pin-1 high) 
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before considering other potential communication problems.  
 
Modifying and Deleting the Peripheral Device Command – Once you have created a command, you can 
modify its parameters or delete it.  Select the command from the Peripheral Device Window and push the 
modify or delete button. 
 

 
 
Using the Peripheral Devices Commands 
From the Dropdown menu - Once you have created at least one peripheral device, a "Peripheral Devices" 
menu will appear in the application.  You can send any of the commands you defined by selecting it from 
the appropriate submenu.   
 

 
 
In a Taskbar - You can also add any of your peripheral device commands to your floating taskbar in the 
same way that you can add any other menu command (see screenshot below).  Once placed on a taskbar, 
simply click on the Peripheral Device command and it will be carried out (For a review of taskbar 
development, see Chapter 12- Taskbars). 
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In a Macro - Finally, you can use any of these peripheral device commands as part of a Macro program 
that you develop.  On playback of the Macro, the peripheral device commands will be carried out in the 
sequence and order specified in the Macro program (see Chapter 13 for a review of developing Macros). 
You can move your peripheral device commands to and from another computer.  To import peripheral 
device commands, follow these steps: 

1. Choose Peripheral Devices from the Setup menu. 

2. Click on Import. 

3. Select the peripheral device export that you would like to import.  This will be a file of type SPOT 
Export (spx). 

4. Choose Open.  The peripheral device export will appear in the Import menu.   

5. Select the peripheral device export and choose Import.  The peripheral device commands will now 
be ready for you to use. 

To export peripheral device commands, follow these steps: 

1. Choose Peripheral Devices from the Setup menu. 

2. Select the peripheral devices you would like to export.  To select multiple peripheral devices, hold 
down the Control button while selecting them.   

3. Click on Export. 

4. Select a File name and location and choose Save. 

Macro Menu 

New Features Available as Macro Commands 
If you use Macros to simplify and stream line your work, you will notice that most of the SPOT Advanced 
Plus features (detailed at the beginning of this chapter) are also available as macro commands.  These new 
commands include: 

Duplicate Image, Create Extended Focus Image, Export Pixel Values, Set Intensity Display 
Scaling, and Send Peripheral Device Command. 
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Chapter 2 - Boost Camera Features 
The Boost cameras offer additional features which can be found under the Image Setup section of the 
software.  Features which are also available in the SPOT Advanced program are detailed in SPOT Software 
User Guide for version 4.7.  Boost camera and Advanced Plus specific features are the only features 
documented here. 

Readout Circuit 
This feature is only available on certain BT2000 
models.  Choices can be made between 14- and 16-
bit readout circuits as well as whether or not the 
Electron Multiplying or Conventional circuit should 
be used.   

Exposure 

Pre-Amp Gain 
The main purpose of the Pre-Amp 
Gain is for controlling the dynamic 
range capabilities of the camera. 
 
For nearly all low light applications, 
try the Pre-Amp Gain at 1.   
Used in conjunction with binning, a 
Pre-Amp Gain setting of less then 1 
will maximize the dynamic range 
capabilities of the camera.   
 
Combining binning with a lower Pre-
Amp Gain setting can help to 
maximize the visualization of bright 
and dark areas (dynamic range) of an 
image as these settings allow for a 
deeper well to be read out by the A/D 
Converter while maximizing the 
spread of the intensity information which is fed to the converter. 

EM Gain 
While the Pre-Amp Gain setting is used to maximize the dynamic range of the camera, the EM Gain is 
primarily used to enhance the signal to noise ratio and increase sensitivity, i.e. detect fewer photons.  It is 
advised to start with a low EM Gain setting and low light and increase the EM Gain as needed.  If the EM 
Gain is set too high, there is a risk of overwhelming the A/D Converter, thus resulting in unrealistic 
darkening of bright areas. 

Shutter 
There are two options for controlling the shutter; most often, the Normal setting will be used. 
 

• Normal-Default selection for normal operation of camera. 
 
• Keep Closed-Internal shutter will remain closed, even during an image capture.  This feature may 

be useful when images of dark current are desired. 
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Sensor Cooling 

Sensor Cooler 
This window allows you to regulate the temperature of the CCD in your camera.  Since the dark current 
noise increases as the temperature of the CCD rises, keeping the temperature of the CCD constant will 
ensure that each image taken has similar dark current characteristics.   
Temperature regulation also increases the accuracy of the background subtraction.  The temperature should 
be the same when creating background subtraction files as when using them.  Please refer to the section 
“Get Background Subtraction” in this chapter for more details. 

To begin regulating, check the Regulate Temperature box, and input the desired temperature in Celsius.  
The thermoelectric cooler will immediately begin cooling (or heating) the CCD to the target temperature.  
The temperature of the CCD is displayed on the status bar across the bottom of your screen.  The 
temperature is read out and updated on the screen every 30 seconds by default.  If you wish to view the 
changes in temperature more regularly, you can change this in the Temperature Readout section of the 
Preferences in the Setup menu.  

The set point for the regulated temperature should be at least 3 degrees warmer than the maximum cooling 
capacity of the camera.  The maximum cooling capacity of the camera is influenced by the room 
temperature.  For example, if the ambient temperature of the room is 20˚C, the maximum cooling 
temperature of an Xplorer camera should be between -45˚C and -49˚C.  The value for the Regulate 
Temperature box should be no more than -42˚C (-45˚C + 3˚C = -42˚C).  If the room temperature is around 
25˚C, the maximum cooling temperature will be closer to -40˚C to -45˚C, and thus the maximum (lowest 
temperature) value that should be used is around -37˚C. 

To optimize the Regulated Temperature 
option, it is recommended to perform a 
small experiment where the Regulated 
Temperature is turned off and the camera is 
allowed to run to its maximum cooling 
possible in the maximum expected room 
temperature.  The SPOT software will 
display the temperature of the camera in the 
status bar at the bottom of the application; 
note this value, add 3˚C, and use the 
resulting value for the Regulated 
Temperature. 

If the temperature of the camera is not 
within the range set by the Regulated 
Temperature and the Allowable Variance, 
an asterisk will be displayed next to the 
temperature display in the bottom of the 
SPOT application.   

 

Fan Speed 
 There are 3 options for Fan Speed: 
• Normal 
• Low  
• Off-If you select the Fan to be set to Off for extended periods of time, the camera will sound an 

alarm to remind you to turn the Fan back on to assist in keeping the CCD cooled. 
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The selection made for Fan Speed will dictate the speed of the Fan while the camera is running, while idle, 
or during image capture.   
 
If further control of the Fan Speed is desired, use the additional check box for “Before Exposing, Set Fan 
Speed to:”.  Once this box is checked, you will have the option to set the Fan Speed to the next lower Fan 
Speed(s), as well as set the time you would like the camera to wait prior to starting an exposure once the 
Fan Speed is adjusted.  If vibrations are of concern, adjusting the Fan Speed prior to exposing may be of 
benefit. 
 

 Note:  We recommend using the water cooler accessory if it is desired that the Fan is turned off 
(as would be necessary for high-speed sequential imaging) or if you need long exposures with the 
Fan off.   

 

WARNING 

IF THE FAN HAS BEEN TURNED OFF AND THE ALARM IS SOUNDING, THE CAMERA’S COOLING 
SYSTEM IS OVERHEATING AND NOT MAINTAINING THE TEMPERATURE INDICATED IN THE IMAGE 
SETUP.  LEAVING THE CAMERA IN THIS CONDITION MAY CAUSE DAMAGE TO THE CAMERA. 

 
 

Image Readout 
Horizontal Readout 
Frequency  
The options available will depend on the 
Readout Circuit (BT2000 only) choice 
indicated and the model of Boost camera.  
Choices for Horizontal Readout 
Frequency may include 1, 3, 5, 10, 13, 27 
and 35 MHz.   
 

Vertical Shift Period 
The Vertical Shift Period is used to speed 
up or slow down how fast the electrons 
are shifted on the CCD for readout.  
Shorter periods can help with frame rate 
and reduce electron smear that may 
appear.  The settings available will depend on the model of the Boost camera and may include options from 
0.1 to 6.5 µsec. 
 
Applications for Long Vertical Shift Periods: 

• Extremely low light level conditions.  In these long exposures, the likelihood of smear is reduced, 
so the longer shift period is typically acceptable.   

• Setups where a region of interest is specified and it is small and close to the bottom of the image. 
 
Applications for Short Vertical Shift Periods: 

• High Light Level Conditions.  In these situations, many electrons are bombarding the CCD, and 
may produce smear while the information is being read off of the CCD.  Shortening the Vertical 
Shift Period can help minimize this smear. 

• Setups where the region of interest is large and/or relatively close to the top of the image. 
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Vertical Clock Voltage Boost 
If a relatively short Vertical Shift Period has been set, you may need to increase the Vertical Clock 
Voltage Boost to help move the electrons from pixel to pixel for proper readout.  The options available 
are 0, 1, 2, 3, and 4.  The following are general guidelines for setting the level of the Vertical Clock 
Voltage Boost: 
 
• Low light level conditions require a low vertical clocking voltage to keep “clock induced charge” 

low.  
• High light levels require a high vertical clocking voltage to better transfer the charge and avoid 

blooming.  
• Very short vertical shift times require a high vertical clocking voltage for better charge transfer 

efficiency to avoid smearing. 
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